IDAHO STATE VETERANS CEMETERY MARKER INSCRIPTION REQUEST
10100 Horseshoe Bend Rd. Boise, ID 83714
Phone: (208) 780-1340 Fax: (208) 780-1341 Email: BoiseCemetery@yveterans.idaho.gov

This form must be submitted to the cemetery office on the day of interment.

FY 2024 See Instructions On Next Page

REQUIRED INFORMATION: Automatically formatted according to regulations & space available.
NAME OF DECEASED:

FIRST NAME (or Initial) MIDDLE NAME (or Initial) LAST NAME

Date of Date of Emblem #: (Optional; See next page)
Birth: Death: or [] None
If Deceased was the Veteran:
Veteran’s Rank: . Veteran’s Service Branch:
War Service: (Optional) Valor Medals: (Optional & Proof Required)
[]WorldWarll []Korea []Vietnam [|PersianGulf []Legion ofMerit []PurpleHeart []Air Medal
[] Other: [] None [] Other: [] None

ADDITIONAL INSCRIPTION:

Punctuation is

limited to:
CASKET BURIAL HEADSTONE: (LIMIT: 15 SPACESPERLINE) & () - : /' 1
BRS i o R A

No Commas,

N W
i Quotation Marks, etc.

Niche Cover:
Two emblems can be inscribed at top when
second person added.

Urn Flat Marker:

One line of inscription is generally available
when second person’s name & dates are
added.

COLUMBARIUM NICHE COVER: (LIMIT: 13 SPACES PER LINE)

Scatter Garden/ Memorial:

“In Memory Of” included. When second
person’s name & dates are added, no
additional space for inscription is common.

Spouse Only Markers Include:
“Wife Of / Husband Of”
Veteran’s Name, Rank & Branch

URN FLAT MARKER: (LIMIT: 27 SPACES PER LINE)

SCATTER GARDEN/ MEMORIAL MARKER: (LIMIT: 22 SPACES PER LINE)

Tunderstand that the information above will be automatically formatted according to regulations & space available. Once submitted,
the cemetery will only accept changes if a factual error has occurred. The marker is delivered approximately 6-12 weeks after
ordered; placement times then vary.

Signature of Next of Kin or Authorized Representative: Relationship: Date:
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“REQUIRED INFORMATION” is automatically formatted according to regulations & space available.

e  All grave markers, for veterans and spouses alike, will include: Name of Deceased, DOB/DOD and Veteran’s name/rank/service
branch. All other information is optional and subject to space available.

o The name line can only contain the name and suffix (Jr, Sr, IlI). Diminutives (i.e. Bill for William) or Maiden Names are allowed.

“TERMS OF ENDEARMENT” is

laced below the required information, and is subject to space available.

o Use this space for nicknames, professional titles, specific battles, words, phrases or other info not already indicated above.

e Number of lines available vary by plot type. Please write what you would like & the office will arrange & notify of any exclusions.

e This can be updated when the second person is laid to rest and a new marker is ordered.
FOR ASSISTANCE, CONTACT THE CEMETERY OFFICE
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Edit a signed PDF | FAQ

If SEDisipnedpmsing a digital ID or certificate, it's locked to
prevent changes to the docurment. Digitat iDs or certificates used o
sign PDFs are used for the commercial and legal purpose and are
governed by laws in many countries.

Can | edit a PDF that | signed?

If you're the only one signer, you can remove the signature and
then work on the document or edit the source document.

To remove your signature, right-click the signature and then choose
Clear Signature.

Dy ;.ﬂl..-u.

John
Doe

View Signed Version

Compare Signed Version to Current Version

Show Signature Properties...

If you got a signed PDF, you can request the signer to remove the
signature and share the PDF or send an unsigned copy of the PDF.

SignIn

ON THIS PAGE p

Can | edit a PDF that |
signed?

Is there a way to retrieve the
unsigned PDF and resign it?

What if a PDF is locked after
signing?

What are the scenarios in
which a PDF is locked?

What if multiple signatures
are needed and the PDF is
locked after the first
signature?

How to handle such issues
better in future?

Applies to: Adobe Acrobat DC

Last Published: August 21,2020





s there a way to retrieve the unsigned PDF
and resign it?

If you're the only one signer, you can remove your signature and
work on the document. If the document is signed by others, you can
request the initiator to share an unsigned copy or the source
document with you.

What if a PDF is locked after signing?

Occasionally, you or the signer may choose to lock the document
after signing. In this case, the document becomes read-only and no
further changes are allowed; even a signature can't be added in the
document. The Lock document after signing option is useful if
you're the last signer or the only one signer.

Sign as "John Bilippi" X

Appearance = Standard Text v
Digitally signed

JOhn by John Bilippi
Date: 2017.07.04

Bilippl 53522 08130

View Certificate Details

“ Lock document after signing

Review document content that may affect signing
Enter the Digital ID PIN or Password...

What are the scenarios in which a PDF is
locked?





When you sign a PDF using your digital ID, the PDF becomes read-
only for others. If you received a PDF digitally signed by others, you
can sign it, but can't edit it.

While signing a PDF, if the signer chooses to lock the document
after signing, the document becomes read-only for everyone,
including the signer.

What if multiple signatures are needed and
the PDF is locked after the first signature?

You have no other option than to create the PDF again or request
the PDF from the owner. Generally, the PDF is locked for editing, but
not for signing unless you or the first signer chooses the Lock
document after signing option while signing.

How to handle such issues better in future?

Before you sign a PDF, you can save a copy of the PDF. Also, while
signing the PDF, you're prompted to save as the PDF. You can
choose a different name so that you have the original PDF unsigned.

If you're expecting others to sign the PDF, don't select the Lock
document after signing option in the Sign As dialog box or the Sign
Document dialog box.

More like this

Edit PDFs
Sign PDFs
Digital IDs
Setting up certificate-based signatures

Validating signatures
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Fillable Forms Tips

Save the form to your computer before completing it

We suggest that you first download the PDF form to your computer or network drive,
and then open it with Adobe Reader and fill it. You can either type information directly
into each field or copy and paste text. The font is preselected and cannot be changed.
You can only type regular text (upper and lower cases); the system will not accept
underlined text, bold or italics, script, or formulas, curved or slanted apostrophes,
double quotation marks or long dashes.

You can save your data and re-open the file later to modify or enter additional
information.

Use the latest version of Adobe Reader

To open and complete the PDF application forms, you will need Adobe Reader (the
latest version is recommended). If you do not have it installed on your computer, you
may download the latest version free of charge from
https://get.adobe.com/reader/otherversions.

Mac users: do not use Preview

For Macintosh system users: DO NOT use the Preview program to fill in the PDF form.
Adobe Reader is the only program that will allow you to work with the form properly and
allow us to read the results once back on a Windows machine. If you do not already
have Adobe Reader, please use the link above to install it to your machine.

Chrome users: do not use Chrome PDF Viewer

For Chrome browser users: DO NOT use the Chrome PDF viewer program to fill in the
PDF form. Adobe Reader is the only program that will allow you to work with the form
properly. If you do not already have Adobe Reader, please use the link above to install it
to your machine. Please use the instructions below to disable Chrome PDF viewer in
your browser.

Turn off in-browser viewing



https://get.adobe.com/reader/otherversions



If you are having problems using the form via your browser, use the instructions here to
turn off in-browser PDF viewing: https://helpx.adobe.com/acrobat/using/display-pdf-
browser-acrobat-xi.html Or, try the instructions below.

Print only when your cursor is not in a form field

Use your mouse to select an area of the form that is not inside a form field or hit the tab
key after completing the entry of your last box before printing your form. If a form field is
active (e.g. contains the blinking bar) the contents of that block will not print.

Print from Acrobat, not the browser

If the fillable form is displayed within your web browser’s window be sure to use the
printer button on the Acrobat toolbar menu to print the form instead of your web
browser’s print function.

Save the file

If you experience problems printing PDF forms once you have filled them in, save the
data file containing your information to your local drive.

Downloading and Saving the Form
Save the form to your computer before attempting to complete it
Fillable PDF forms may be completed and saved using Adobe Acrobat Reader (this

software must be loaded on your computer). To accomplish this, you must first save the
empty form on your own computer:

1. Position your cursor on the form link and click with your right mouse button
(do not activate the link and open the form)

2. From the menu that pops up, select the Save target as... option in Internet
Explorer or the Save link as... or similar option in another browser

3. You should then be prompted to choose a location to save the file

4. Select the location on your own computer or network and click on the Save
button



https://helpx.adobe.com/acrobat/using/display-pdf-browser-acrobat-xi.html

https://helpx.adobe.com/acrobat/using/display-pdf-browser-acrobat-xi.html

https://get.adobe.com/reader/otherversions/



5. Once saved, navigate to the file

Completing fillable forms
Fill out the form and save it using Adobe Acrobat Reader:
1. Use the Adobe Acrobat Reader to open the empty PDF form that you saved
on your own computer or network
Complete the form
On the Reader menu, go to File > Save As

Choose either the PDF (recommended) or Text format

o & Db

You should then be prompted to choose a location to save the file

6. Select the location on your own computer or network and click Save

Troubleshooting
Form or Field Exceeds Printed Page

If you cannot see the complete text of what you typed, your text is too long. You must
shorten your entry to the words you can see, as only visible text will be printed.

Some printers may require use of the “Shrink to Fit” printer dialog box to be checked to
print the form on a single page.

A .pdf file does not open

You clicked the link for a .pdf file and the file did not open. Adobe Reader, or equivalent
software, may not be installed on your computer. Install the software and try to open the
.pdf file again.

Unable to view or download a .pdf file using Adobe Reader

You cannot view, print, or download a .pdf file in Adobe Reader. To resolve this, modify
your Reader PDF viewer preferences:

1. Close the browser
2. Open Adobe Reader

3. On the menu bar, go to Edit > Preferences > Internet





4. Under Options, make sure that Display PDF in Browser is not selected
The next time you click on a link to a .pdf form or publication, it will open in a
separate browser window.
A .pdf does not print correctly or does not print at all

You can try to resolve the problem by printing the PDF as an image.
If you are using Adobe Reader:

1. Click on the print icon
In the Print dialog box, click Advanced

Check the Print As Image checkbox

T

Click OK to close the Advanced Print Setup dialog box

5. Click OK or Print in the Print dialog box
If printing the PDF as an image does not resolve the problem, try the following:

e Make sure you are using the latest printer driver for your printer
e Try printing to a different printer
e Download the file again to your hard drive and print

o Refer to your printer manual for further assistance
Unable to use Google Chrome and Safari PDF viewers

In some cases, the PDF viewer is embedded in the browser itself. Below are solutions
for resolving problems with Google Chrome and Safari viewers.

Unable to use the Google Chrome PDF viewer

The Google Chrome built-in PDF viewer may not allow you to view a PDF or access
certain functionalities, or functions such as automatic calculation may not work as
expected. To resolve this, follow these steps:

1. Open Chrome and, in the address bar, type: chrome://plugins/, and then
press [Enter]

2. Scroll down to the Chrome PDF Viewer
3. Click the Disable link to prevent PDFs from loading within Chrome

4. Download the files onto your computer





5. Open them in another standalone application such as Adobe Reader
Unable to use the Safari PDF viewer

The Safari built-in PDF viewer may not allow you to view a PDF or access certain
functionalities. To resolve this, follow these steps:

1. Close Safari

2. Open Terminal and type the following:
defaults write com.apple.Safari WebKitOmitPDFSupport -bool YES

3. Restart Safari

4. Click on a PDF to download it to the Downloads folder
Change the default PDF viewer in Firefox

Firefox users may also wish to change their default viewer to Adobe Reader.
1. Open Firefox and navigate to Tools > Options
2. Click on the Applications tab

3. Under Content Type, scroll down to Portable Document Format (PDF) and,
from the Action dropdown menu, select Use Adobe Reader

4. Close the Options tab or window
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Sign PDFs

Search Adobe Support
Reader lets you sign PDFs and incorporaie that signature into ine
file. If you are viewing a PDF on the web, download the PDF first
before you sign it. Some documents have security applied that
prohibits electronic signatures. Print such documents and then sign
the printed copy.

Quickly fill and sign any PDF form online.

Try now for free

Sign a PDF

To sign a PDF document or form, you can type, draw, or insert an
image of your handwritten signature. You can also add text, such as
your name, company, title, or the date. When you save the
document, the signature and text become part of the PDF.

v Steps to sign a PDF

1 Open the PDF document or form that you want to sign.

Click the Sign icon Eil in the toolbar. Alternatively, you
can choose Tools > Fill & Sign or choose Fill & Sign from
the right pane.

Sign In

ON THIS PAGE p

Sign a PDF

Send and track your signed
PDFs

Get PDFs signed by others
using Adobe Sign

Manage certificates (secured
PDFs)

Applies to: Acrobat Reader DC

Last Published: October 14, 2020





Fle Edt View Window Help

Home  Tools AowWisotpdt ® a9
683 Q " hOO0@ wm- K T 8 o]
—

o Type or print your first name and middle initial Last name Social Security Number B

The Fill & Sign tool is displayed. Click Fill and Sign.

| rorsion
“
. . 23
Who needs to fill and sign?
e
=
=
®
You Others

Fill form fields, add text and draw or ‘Add signers, mark where to fill and

type your signature. sign, send it out and track progress.
nﬁdbbeswgn l‘"

The form fields are detected automatically. Hover the
mouse over a field to display a blue box. Click anywhere in
the blue box, the cursor will be placed at the right position
automatically. Type your text to fill the field.

X-5 |Employee xxxxx Certificate
Form - ! -
Some descriptions of this form. Some descriptions 20 1 8
Department of of this form. Some descriptions of this form. Some
Human Resource descriptions of this form.
Type or print your first name and middle initial. Last name Social Security Number

Home address (number and street or rural route)
Single D Married D

Please see the comments somewhere.

Hover the mouse to display the detected text field

You can choose your desired color to fill the PDF form.
Click the color button in the Fill & Sign menu and choose
your desired color.





Fill & Sign B X v O — o | ghso @ @
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@ Color ~ Ea’
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Retain original color for signatures "|:|

By default, the signature color is black. To retain the default
color of the signature, make sure the Retain Original Color
For Signature option is unchecked.

Note:

For more information on filling your form, see Fill out your
PDF form.

> Click the Sign icon éf» in the toolbar, and then choose
whether you want to add your signature or just initials.

If you have already added signatures or initials, they are
displayed as options to choose from.

6  If you've already added your signature or initials, just select
it from the Sign options, and then click at the place in the
PDF where you want to add your signature. Skip to the
next step.

If you are signing for the first time, you see the Signature or
Initials panel. Below is an example of the Signature panel.





’ B2 & &

Qf’ém pﬁaj

Save signature

You can choose to type, draw, or import a signature image.
Added signatures and initials are saved for future use.

- Type: Type your name in the field. You can choose
from a small selection of signature styles; click Change
Style to view a different style.

- Draw: Draw your signature in the field.
- Image: Browse and select an image of your signature.

- Save Signature: When this check box is selected, and
you're signed in to Acrobat Reader or Acrobat, the
added signature is saved securely in Adobe Document
Cloud for reuse.

Click Apply, and then click at the place in the PDF where
you want to place the signature or initial.

To move the placed signature or initial, click the field to
highlight it and then use the arrow keys. To resize or delete
the field, use the options in field toolbar.

Note:
If you want to use an image as your signature:

- Sign your name in black ink on a clean, blank sheet of white
paper. Sign in the middle of the paper so you don't
photograph or scan the edges.

- Photograph or scan your signature. If you are taking a picture
of your signature, make sure that the page is lit and that no
shadows fall across the signature.






- Transfer the photo or scan to your computer. Acrobat/Reader
accepts JPG, JPEG, PNG, GIF, TIFF, TIF, and BMP files. You do
not need to crop the image. Acrobat/Reader imports just the
signature if the photo or scan is fairly clean.

Send and track your signed PDFs

After you have signed the form, you can share it with others. To
share the form, follow the steps mentioned in the article Send your

form.

Get PDFs signed by others using Adobe Sign

For more information, see Send PDF documents for signature.

Manage certificates (secured PDFs)

The creator of a PDF can encrypt the document with a certificate for
verifying digital signatures. Certificates that you receive from others
are stored in a list of trusted identities. This list resembles an address
book and enables you to validate the signatures of these users on
any documents you receive from them.

For more information, see these articles in Acrobat Help:

- Certificate-based signatures
- Securing PDFs with certificates
- Validating digital signatures

- Manage trusted identities

Legal Notices | Online Privacy Policy
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IDAHO STATE VETERANS CEMETERY MARKER INSCRIPTION REQUEST
10100 Horseshoe Bend Rd. Boise, ID 83714
Phone: (208) 780-1340 Fax: (208) 780-1341 Email: BoiseCemetery(@veterans.idaho.gov
This form must be submitted to the cemetery office on the day of interment.

FY 2023 See Instructions On Next Page
REQUIRED INFORMATION: Automatically formatted according to regulations & space available.
NAME OF DECEASED:
MARY J SMITH

FIRST NAME (or Initial) MIDDLE NAME (or Initial) LAST NAME
Date of 05/15/1935 Date of 02/27/2023 Ml Aptloual; Bosmert pagd
If Deceased was the Veteran:
Veteran’s Rank: . Veteran’s Service Branch:
War Service: (Optional) als: (Optional & Proof Required)
[JWorld Warll []Korea []Vietna sian Gulf [ ] Legion of Merit [ ] Purple Heart [] Air Medal
[] other: [] None [] other: [] None

ADDITIONAL INSCRIPTION:

Punctuation is

CASKET BURIAL HEADSTONE: (LIMIT: 15 SPACES PERLINE) 2 ()”"‘f’te_d t;’ .
DIA|U|G|H|T|E|R M|O|T|H|E|R Filgag Ee Eé A3 A &
GIRIA|INID|IMIA FIRIITIEINID \\\\\\r No Commas,

Quotation Marks, etc.

Niche Cover:
Two emblems can be inscribed at top when
second person added.

Urn Flat Marker:

One line of inscription is generally available
when second person’s name & dates are
added.

COLUMBARIUM NICHE COVER: (LIMIT: 13 SPACES PER LINE)

Scatter Garden/ Memorial:

“In Memory Of” included. When second
person’s name & dates are added, no
additional space for inscription is common.

URN FLAT MARKER: (LIMIT: 27 SPACES PER LINE) ; — §V;|;;>u0sf(; 2nll,y lzlg;:kers Include:
lje uspan

Veteran’s Name, Rank & Branch

SCATTER GARDEN/ MEMORIAL MARKER: (LIMIT: 22 SPACES PER LINE)

Tunderstand that the information above will be automatically formatted according to regulations & space available. Once submitted,
the cemetery will only accept changes if a factual error has occurred. The marker is delivered approximately 6-12 weeks after
ordered; placement times then vary.

Signature of Next of Kin or Authorized Representative: Relationship: Date:

SON 03/05/2023






IDAHO STATE VETERANS CEMETERY MARKER INSCRIPTION REQUEST
10100 Horseshoe Bend Rd. Boise, ID 83714
Phone: (208) 780-1340 Fax: (208) 780-1341 Email: BoiseCemetery(@veterans.idaho.gov

This form must be submitted to the cemetery office on the day of interment.

FY 2023 See Instructions On Next Page

REQUIRED INFORMATION: Automatically formatted according to regulations & space available.
NAME OF DECEASED:

MARY JO SMITH
FIRST NAME (or Initial) MIDDLE NAME (or Initial) LAST NAME
Date of Date of Emblem #: (Optional; S t
Rirth: 09/10/1955 =wrion 02/01/2023 (Op o 1 Nome | £)
If Deceased was the Veteran:

Veteran'’s Rank: . Veteran'’s Service Branch:

War Service: (Optional) S: (Optional & Proof Required)

[JWorld Warll []Korea []Vietna [] Legion of Merit [ ] Purple Heart [] Air Medal

[] other: [J None [] other: [J None

ADDITIONAL INSCRIPTION:

Punctuation is

limited to:
CASKET BURIAL HEADSTONE: (LIMIT: 15 SPACES PER LINE) - & () . / |
2 Tt < Ee Eé A3 A &
\ ) B
A\ ’ No Commas,
i Quotation Marks, etc.

Niche Cover:
Two emblems can be inscribed at top when
second person added.

Urn Flat Marker:

One line of inscription is generally available
when second person’s name & dates are
added.

COLUMBARIUM NICHE COVER: (LIMIT: 13 SPACES PER LINE)

Scatter Garden/ Memorial:

“In Memory Of” included. When second
person’s name & dates are added, no
additional space for inscription is common.

URN FLAT MARKER: (LIMIT: 27 SPACES PER LINE) ' ’ ] ] Svl;;)u;; gnzy lt\i’lgf{kers Include:
Ije usban

Veteran’s Name, Rank & Branch

SCATTER GARDEN/ MEMORIAL MARKER: (LIMIT: 22 SPACES PER LINE)

Iunderstand that the information above will be automatically formatted according to regulations & space available. Once submitted,
the cemetery will only accept changes if a factual error has occurred. The marker is delivered approximately 6-12 weeks after
ordered; placement times then vary.

Signature of Next of Kin or Authorized Representative: Relationship: Date:

SPOUSE 02/15/2023






IDAHO STATE VETERANS CEMETERY MARKER INSCRIPTION REQUEST
10100 Horseshoe Bend Rd. Boise, ID 83714
Phone: (208) 780-1340 Fax: (208) 780-1341 Email: BoiseCemetery@veterans.idaho.gov

This form must be submitted to the cemetery office on the day of interment.

FY 2023 See Instructions On Next Page
REQUIRED INFORMATION: Automatically formatted according to regulations & space available.
NAME OF DECEASED:
M JO SMITH

FIRST NAME (or Initial) MIDDLE NAME (or Initial} LAST NAME
Date of Date of Emblem #: (Optional; See next page
Bt 10/13/1950 = 01/01/2023 i CpHarAl e page]
If Deceased was the Veteran:
Veteran’s Rank: . Veteran’s Service Branch:
War Service: (Optional) als: (Optional & Proof Required)
[JWorld Warll []Korea []Vietna sian Gulf  [] Legion of Merit [] Purple Heart [] Air Medal
[] other: [ None [ other: [ None

ADDITIONAL INSCRIPTION:

Punctuation is

limited to:
CASKET BURIAL HEADSTONE: (LIMIT: 15 SPACESPERLINE) & () -+ / 71
[ Sl ;v*g\. B Ee ALA R
\\\\\\ N A No Commas,

Quotation Marks, etc.

Niche Cover:
Two emblems can be inscribed at top when
second person added.

Urn Flat Marker:

One line of inscription is generally available
when second person’s name & dates are
added.

COLUMBARIUM NICHE COVER: (LIMIT: 13 SPACES PER LINE)

Scatter Garden/ Memorial:

“In Memory Of” included. When second
person’s name & dates are added, no
additional space for inscription is common.

URN FLAT MARKER: (LIMIT: 27 SPACES PER LINE) N o Spouse Only Markers Include:

“Wife Of / Husband Of”
[N O|UIR HIEIAIRITIS FIo|IR|IE|IVIEIR & Veteran’s Name, Rank & Branch

Y(O|U A[R|E [N G|O|Df"'|S H[A|N[D|S N|O(W

SCATTER GARDEN/ MEMORIAL MARKER: (LIMIT: 22 SPACES PER LINE)

Iunderstand that the information above will be automatically formatted according to regulations & space available. Once submitted,

the cemetery will only accept changes if a factual error has occurred. The marker is delivered approximately 6-12 weeks after
ordered; placement times then vary.

Signature of Next of Kin or Authorized Representative: Relationship: Date:

SPOUSE 01/15/2023






IDAHO STATE VETERANS CEMETERY MARKER INSCRIPTION REQUEST
10100 Horseshoe Bend Rd. Boise, ID 83714
Phone: (208) 780-1340 Fax: (208) 780-1341 Email: BoiseCemetery@veterans.idaho.gov

This form must be submitted to the cemetery office on the day of interment.

FY 2023 See Instructions On Next Page
REQUIRED INFORMATION: Automatically formatted according to regulations & space available.
NAME OF DECEASED:
MARY J SMITH

FIRST NAME (or Initial) MIDDLE NAME (or Initial} LAST NAME
pate of 01/20/1960 Date of 02/01/2023 e L s g
If Deceased was the Veteran:
Veteran’s Rank: . Veteran’s Service Branch:
War Service: (Optional) als: (Optional & Proof Required)
[JWorld Warll []Korea []Vietna sian Gulf  [] Legion of Merit [] Purple Heart [] Air Medal
[] other: [ None [ other: [ None

ADDITIONAL INSCRIPTION:

Punctuation is

limited to:
CASKET BURIAL HEADSTONE: (LIMIT: 15 SPACESPERLINE) & () -+ / 71
[ Sl ;v*g\. B Ee ALA R
\\\\\\ N A No Commas,

Quotation Marks, etc.

Niche Cover:
Two emblems can be inscribed at top when
second person added.

Urn Flat Marker:

One line of inscription is generally available
when second person’s name & dates are
added.

COLUMBARIUM NICHE COVER: (LIMIT: 13 SPACES PER LINE)

Scatter Garden/ Memorial:

“In Memory Of” included. When second
person’s name & dates are added, no
additional space for inscription is common.

URN FLAT MARKER: (LIMIT: 27 SPACES PER LINE) ' ) o SVII;?HOS;; gnll)y lt\;lgffkers Include:
ije uspan
Veteran’s Name, Rank & Branch

SCATTER GARDEN/ MEMORIAL MARKER: (LIMIT: 22 SPACES PER LINE)

Iunderstand that the information above will be automatically formatted according to regulations & space available. Once submitted,

the cemetery will only accept changes if a factual error has occurred. The marker is delivered approximately 6-12 weeks after
ordered; placement times then vary.

Signature of Next of Kin or Authorized Representative: Relationship: Date:

DAUGHTER 02/15/2023







IDAHO STATE VETERANS CEMETERY MARKER INSCRIPTION REQUEST
10100 Horseshoe Bend Rd. Boise, ID 83714
Phone: (208) 780-1340 Fax: (208) 780-1341 Email: BoiseCemetery(@veterans.idaho.gov
This form must be submitted to the cemetery office on the day of interment.

FY 2023 See Instructions On Next Page

REQUIRED INFORMATION: Automatically formatted according to regulations & space available.
NAME OF DECEASED:

JOE G SMITH

FIRST NAME (or Initial} MIDDLE NAME (or Initial) LAST NAME
Date of Date of Emblem #: (Optional; See next page
e 06/14/1930 vt 04/01/2023 b (Optlon: S None )
If Deceased was the Veteran:
Veteran’s Rank: SGT . Veteran’s Service Branch: ARMY
War Service: (Optional) Valor Medals: (Optional & Proof Required)
[JWorld War1l [s] Korea []Vietnam []Persian Gulf []LegionofMerit []PurpleHeart []Air Medal
[] other: [] None [] other: [] None

ADDITIONAL INSCRIPTION:

Punctuation is

limited to:
CASKET BURIAL HEADSTONE: (LIMIT: 15 SPACES PER LINE) R & ( ) . / S

Ee Eé A3 A &
No Commas,
Quotation MarKks, etc.

Niche Cover:
Two emblems can be inscribed at top when
second person added.

Urn Flat Marker:

One line of inscription is generally available
when second person’s name & dates are
added.

COLUMBARIUM NICHE COVER: (LIMIT: 13 SPACES PER LINE)

Scatter Garden/ Memorial:

“In Memory Of” included. When second
person’s name & dates are added, no
additional space for inscription is common.

URN FLAT MARKER: (LIMIT: 27 SPACES PER LINE) o S §Vl;?u05ft; I({)niljy I:Igfgkers Include:
Ije uspan

Veteran’s Name, Rank & Branch

SCATTER GARDEN/ MEMORIAL MARKER: (LIMIT: 22 SPACES PER LINE)

Tunderstand that the information above will be automatically formatted according to regulations & space available. Once submitted,
the cemetery will only accept changes if a factual error has occurred. The marker is delivered approximately 6-12 weeks after
ordered; placement times then vary.

Signature of Next of Kin or Authorized Representative: Relationship: Date:

DAUGHTER 04/15/2023






IDAHO STATE VETERANS CEMETERY MARKER INSCRIPTION REQUEST
10100 Horseshoe Bend Rd. Boise, ID 83714
Phone: (208) 780-1340 Fax: (208) 780-1341 Email: BoiseCemetery(@veterans.idaho.gov
This form must be submitted to the cemetery office on the day of interment.

FY 2023 See Instructions On Next Page

REQUIRED INFORMATION: Automatically formatted according to regulations & space available.
NAME OF DECEASED:

JOE GREG SMITH

FIRST NAME (or Initial) MIDDLE NAME (or Initial} LAST NAME
Date of Date of Emblem #: (Optional; See next page
Birthe 09/18/1940 i 03/01/2023 (Op or [ None )
If Deceased was the Veteran:
Veteran’s Rank: A1C . Veteran’s Service Branch: AIR FORCE
War Service: (Optional) Valor Medals: (Optional & Proof Required)
[JWorld Warll []Korea []Vietnam []Persian Gulf []Legion of Merit []PurpleHeart [a]Air Medal
[] other: [w] None [] Other: [] None

ADDITIONAL INSCRIPTION:

Punctuation is
limited to:

& () - /1
Ee Eé A3 A &
No Commas,
Quotation Marks, etc.

CASKET BURIAL HEADSTONE: (LIMIT: 15 SPACES PER LINE)

Niche Cover:
Two emblems can be inscribed at top when
second person added.

COLUMBARIUM NICHE COVER: (LIMIT: 13 SPACES PER LINE)
Urn Flat Marker:
MIALY YI|IO|U BIE AlT One line of inscription is generally available
when second person’s name & dates are
PIE|A|C|E| |N|O|wW| |A[N|D added:
Scatter Garden/ Memorial:
F O R E V E R | N “In Memory Of” included. When second
person’s name & dates are added, no
O|UIR HIEIAIRITIS additional space for inscription is common.
URN FLAT MARKER: (LIMIT: 27 SPACES PER LINE) Spouse Only Markers Include:

“Wife Of / Husband Of”
Veteran’s Name, Rank & Branch

SCATTER GARDEN/ MEMORIAL MARKER: (LIMIT: 22 SPACES PER LINE)

I understand that the information above will be automatically formatted according to regulations & space available. Once submitted,
the cemetery will only accept changes if a factual error has occurred. The marker is delivered approximately 6-12 weeks after
ordered; placement times then vary.

Signature of Next of Kin or Authorized Representative: Relationship: Date:

SON 03/15/2023






IDAHO STATE VETERANS CEMETERY MARKER INSCRIPTION REQUEST
10100 Horseshoe Bend Rd. Boise, ID 83714
Phone: (208) 780-1340 Fax: (208) 780-1341 Email: BoiseCemetery(@veterans.idaho.gov

This form must be submitted to the cemetery office on the day of interment.

FY 2023 See Instructions On Next Page

REQUIRED INFORMATION: Automatically formatted according to requlations & space available.
NAME OF DECEASED:

J G SMITH

FIRST NAME (or Initial) MIDDLE NAME (or Initial} LAST NAME
Date of Date of Emblem #: (Optional; See next page
Birth: 10/13/1940 Dttt 01/01/2023 i [Op or [ Nome )
If Deceased was the Veteran:
Veteran’s Rank: SN . Veteran’s Service Branch: NAVY
War Service: (Optional) Valor Medals: (Optional & Proof Required)
[JWorld Warll []Korea []Vietnam []Persian Gulf []LegionofMerit []PurpleHeart []AirMedal
[]J other: [w] None [] other: [] None

ADDITIONAL INSCRIPTION:

Punctuation is

limited to:
CASKET BURIAL HEADSTONE: (LIMIT: 15 SPACES PER LINE) & () - : / ' 1
& b P Ee E¢ A5 A &

No Commas,

N » 3\
i Quotation Marks, etc.

Niche Cover:
Two emblems can be inscribed at top when
second person added.

Urn Flat Marker:

One line of inscription is generally available
when second person’s name & dates are
added.

COLUMBARIUM NICHE COVER: (LIMIT: 13 SPACES PER LINE)

Scatter Garden/ Memorial:

“In Memory Of” included. When second
person’s name & dates are added, no
additional space for inscription is common.

URN FLAT MARKER: (LIMIT: 27 SPACES PER LINE) : S Spouse Only Markers Include:
“Wife Of / Husband Of”
ulsls EINITIEIRIPIRIIISI|E Veteran’s Name, Rank & Branch

SCATTER GARDEN/ MEMORIAL MARKER: (LIMIT: 22 SPACES PER LINE)

Tunderstand that the information above will be automatically formatted according to regulations & space available. Once submitted,
the cemetery will only accept changes if a factual error has occurred. The marker is delivered approximately 6-12 weeks after
ordered; placement times then vary.

Signature of Next of Kin or Authorized Representative: Relationship: Date:

SPOUSE 01/15/2023






IDAHO STATE VETERANS CEMETERY MARKER INSCRIPTION REQUEST
10100 Horseshoe Bend Rd. Boise, ID 83714
Phone: (208) 780-1340 Fax: (208) 780-1341 Email: BoiseCemetery(@veterans.idaho.gov

This form must be submitted to the cemetery office on the day of interment.

FY 2023 See Instructions On Next Page
REQUIRED INFORMATION: Automatically formatted according to regulations & space available.
NAME OF DECEASED:
JOE G SMITH

FIRST NAME (or Initial) MIDDLE NAME (or Initial) LAST NAME
Date of 11/10/1940 Date of 02/01/2023 Emblerg #: (Optiona ';Seiﬁfﬁ page)
If Deceased was the Veteran:
Veteran’s Rank: GYSGT . Veteran'’s Service Branch: MARINE CORPS
War Service: (Optional) Valor Medals: (Optional & Proof Required)
[Jworld Warll []Korea [s]Vietnam []PersianGulf []Legion of Merit [s] Purple Heart [] Air Medal
[] other: [] None [] other: [ None

ADDITIONAL INSCRIPTION:

Punctuation is

limited to:
CASKET BURIAL HEADSTONE: (LIMIT: 15 SPACES PER LINE) 2 ()'"f' e 7 o
R ' Ee Eé A5 A &
No Commas,
Quotation Marks, etc.

e :
- % ‘ ¥ 2
L N\

Niche Cover:
Two emblems can be inscribed at top when
second person added.

Urn Flat Marker:

One line of inscription is generally available
when second person’s name & dates are
added.

COLUMBARIUM NICHE COVER: (LIMIT: 13 SPACES PER LINE)

Scatter Garden/ Memorial:

“In Memory Of” included. When second
person’s name & dates are added, no
additional space for inscription is common.

URN FLAT MARKER: (LIMIT: 27 SPACES PER LINE) . o ?M];;)u(;(-;gnzy l:j/lg;kers Include:
ife ushan
Veteran’s Name, Rank & Branch

SCATTER GARDEN/ MEMORIAL MARKER: (LIMIT: 22 SPACES PER LINE)

Iunderstand that the information above will be automatically formatted according to regulations & space available. Once submitted,
the cemetery will only accept changes if a factual error has occurred. The marker is delivered approximately 6-12 weeks after
ordered; placement times then vary.

Signature of Next of Kin or Authorized Representative: Relationship: Date:

SPOUSE 02/15/2023
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